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Contact and Support Information
Return to Table of Contents.

Product and account information can be accessed by visiting Customer Support online at
Support.CCH.com/Axcess. In addition to product and account information, the Customer Support site offers
answers to our most frequently asked questions, forms release status, Knowledge Base articles, training
videos, and operating systems compatibility for each CCH Axcess module. Access to these features is
available 24/7.

The following Web site provides important information about the features and updates included in all CCH
Axcess Tax releases: Release Notes

Visit the Application Status Web page to view the current status of our CCH Axcess applications. The
Application Status Web page is updated every 15 minutes.

Go to Contact Us to find Support calendars, as well as options to enter Web tickets for assistance.
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Information in Tax Year 2014 Release Notes
Return to Table of Contents.

CCH Axcess Tax Release Notes inform you of the enhancements and updates that have been made to Tax
products and systems with the current release.

The updates provided in the Release Notes include the following:

Contact and Support information
Updates to Tax technology (electronic filing updates, Organizer, roll forward, technology
enhancements)
Updates made to Tax products (form additions and updates, changes in diagnostics, changes
caused by regulatory updates)

To access a list of CCH Axcess Tax Release Notes for the current year and for prior years, visit the Release
Notes page on our Customer Support site.
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Highlights for Release 2014-3.1
Return to Table of Contents.

2014 Tax Updates

Individual

Form 8962. Based on the release of IRS Publication 974, the following worksheets have been
added:

Worksheet W - Figuring Household Income and the Limitation on Additional Tax

Worksheet X - Figuring the Limit Under Section 5.03 of Revenue Procedure 2014-41

Step 3 Worksheet - Self-Employed Health Insurance Deduction for Specified Premiums

Step 5 Worksheet - Refigure Your Self-Employed Health Insurance Deduction for Specified
Premiums

Further updates regarding Form 8962:
If the option to do the alternative calculation for year of marriage is selected and
Worksheet I, Line 4, is greater than 400, Worksheet II is not completed. If Worksheet III,
Line 4, is greater than 400, Worksheet IV is not completed.
When Form 8962, Line 3, equals zero, Line 7 is equal to .02.

When information is present to complete the Shared Policy Allocation and the calculated
premium percentage, SLCSP premium percentage and the advanced payment of PTC
percentage are all zero, zero will print for the premium percentage.
When zero exemptions are claimed in the return, per Publication 974, Lines 1, 2a, 3, 4
and 5 are filled with zero and only Column F of Lines 11 through 23 is completed.

Georgia has adopted the provisions of all federal acts as they relate to the computation of federal adjusted
income that were enacted on or before January 1, 2015.

The following items are no longer adjustments on Individual returns:

Form 500, Page 4, Schedule 1, Line 4 as other additions:
Educator expense deduction

Tuition and fees deduction

Qualified charitable contributions

Enhanced deduction for charitable contributions of capital gain real property

Form 500, Page 2, Line 12, or Form 500, Page 6, Line 10, as itemized deduction:
Deduction for state and local general sales tax

Qualified mortgage insurance premiums deductible as home

2014 Electronic Filing
The following federal and state returns are approved and available on this release:
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Partnership

Arkansas Magnetic Media
California Magnetic Media
Louisiana
Louisiana Extension
New Jersey Magnetic Media

S Corporation

Arkansas Magnetic Media
New Jersey Magnetic Media

Fiduciary
Kansas

Employee Benefit Plan
Electronic filing of Form 8955-SSA is now available in accordance with the IRS electronic filing mandate.
You will find your 8955-SSA return as “SA” under the ‘State/FBAR’ column on the Electronic Filing Status
System. Also, should you choose to add the ‘State Category’ column to your view, it will be listed as “8955-
SSA.”
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Tax Product Updates

Individual (1040) Product Updates
Return to Table of Contents.

Federal
8863. Foreign country code and foreign province input on the Basis Data > General worksheet will not
automatically fill the Educational Institution address on the Tuition Statement.

8903. DPGR ratio for Schedule F is calculated as DPGR divided by Schedule F, Line 9, when DPGR is input on
Farm / 4835 > Domestic Production Activities Deduction > Portion of income from domestic production gross
receipts - Amount.

Diagnostic 26047 will issue when a state code is entered on the Wages, Salaries and Tips worksheet but that
state is not prepared in the return.

Education optimization for Form 8863 and Form 8917 will calculate for up to two students requesting
optimization even if those two students have educational expenses on more than two educational
institutions.

Form 114. An account owner country field has been added to the 114 and 8938 - Foreign Assets > Report of
Foreign Bank and Financial Accounts summary grid.

Form 4562. Current year depreciation calculates on assets subject to recapture and that had also claimed
bonus in the prior year.

Form 4562. The boot asset in a LKE (like kind exchange) is allowed the increased auto limits when qualified
for bonus depreciation.

Form 4797 AMT. Line 24 will include AMT depreciation when different from regular depreciation for a
Section 1245 installment sale transaction.

Form 6251. Line 17 will not add back the amount of casualty loss postponed when the cost of replacement
property exceeds the reimbursement amount.

Form 8858 attachment to Form 5471. When Schedule G , Question 4, is answered "No," the amount of loss
will now be left blank.

Form 8889. The total amount of unreimbursed qualified medical expenses entered on the Health Savings
Accounts > General Information worksheet carries to Line 15.

Form 8962. Based on the release of IRS Publication 974, the following worksheets have been added:

Worksheet W - Figuring Household Income and the Limitation on Additional Tax
Worksheet X - Figuring the Limit Under Section 5.03 of Revenue Procedure 2014-41
Step 3 Worksheet - Self-Employed Health Insurance Deduction for Specified Premiums
Step 5 Worksheet - Refigure Your Self-Employed Health Insurance Deduction for Specified
Premiums

Form 8962. If the option to do the alternative calculation for year of marriage is selected and Worksheet I,
Line 4, is greater than 400, Worksheet II is not completed. If Worksheet III, Line 4, is greater than 400,
Worksheet IV is not completed.

Form 8962. When Form 8962, Line 3, equals zero, Line 7 is equal to .02.
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Form 8962. When information is present to complete the Shared Policy Allocation and the calculated
premium percentage, SLCSP premium percentage, and the advanced payment of PTC percentage are all
zero, zero will print for the premium percentage.

Form 8962. When zero exemptions are claimed in the return, per Publication 974, Lines 1, 2a, 3, 4, and 5,
are filled with zero and only Column F of Lines 11 through 23 is completed.

Philadelphia letters and filing instructions will reference electronic filing.

Schedule B. Amounts of special interest entered on Income/Deductions > Consolidated 1099 > Form 1099-
INT Interest Income without another type of interest are included on Schedule B once.

Schedule B. Entries for nominee dividends entered in combination with exempt-interest dividends either on
Income/Deductions > Dividends (Detail) > IRS 1099-DIV or on Income/Deductions > Consolidated 1099 >
Form 1099-DIV Dividend Income are allocated to the exempt-interest dividends and are deducted once on
Schedule B.

Schedule C. Prior-year fully depreciated vehicles entered on Business > Depreciation and Amortization will
calculate a deduction based on mileage when Section 179 was used to fully depreciate the asset. Also, these
assets will not use the mileage deduction when the option to use actual amounts has been chosen for the
Income/Deductions > Business > General > Force actual on depreciation field.

Schedule E, Page 2. When a passthrough activity is coded as nonpassive, and there is a prior passive activity
loss, and the activity is marked as disposed of, Schedule E, Page 2, Line 27, will be answered "Yes."

Schedule J. When calculating the optimized amount to be reported on Line 2, capital losses are not added
back to the current year taxable income.

Schedule SE. Line 2 ignores the entry on Other Income > Miscellaneous Income (IRS 1099-MISC) > Other >
Income code when attached to the Schedule C so that the income is reported once.

Tax Equalization - Cash Flow Statement #2. Hypothetical tax for Arkansas consists of Total Tax Liability
rather than Net Tax after Nonrefundable Credits.

Tax Equalization. The following forms are provided to facilitate the hypothetical return review process by
displaying amounts from both the actual return and the hypothetical return:

Other taxes worksheet
Form 8912

Tax Equalization. The Wages worksheet accepts overrides for hypothetical wages for both federal and state
amounts to accommodate situations where U.S. wages are different from hypothetical amounts.

The accumulated depreciation in the Depreciation and Amortization worksheet rolls forward the prior year's
accumulated depreciation plus the current year depreciation when the attachment entity does not have the
Pro Forma Only option selected.

The cost/basis splits on the Gains/Losses > Business Property > Casualties and Thefts section when the
automatic sale feature is used.

Electronic Filing
EIN prefixes "96" and "97" are valid prefixes per the IRS, and disqualifying diagnostics will no longer be
issued for EINs beginning with these prefixes.

Form 114 Electronic Filing. Financial account information for records with the option to "Exclude from 114"
selected are not included in the electronic file.

Form 2441. Disqualifying diagnostic 40243 will not issue for care provider EINs starting with "69."
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Schedule EIC. A taxpayer/spouse born on January 1, 1950, is considered 64 instead of 65 for EIC calculation
purposes.

Arizona
Arizona part-year Schedule A, Line 17, includes gambling winnings coded to Arizona and entered on the IRS-
W2G.

For taxpayers who are classified as a farmer or fisherman with no underpayment penalty being calculated
and who have a date filed entered before 3/1, the Form 221 Attached box on the Arizona main form will not
be filled.

Other gains and losses will no longer appear as capital gains and losses on Form 140NR, Line 20, or Form
140PY, Line 21. Other gains and losses will now appear on Form 140NR, Line 22, or Form 140PY, Line 23, as
other income. This also affects Form 140NR, Line 31, and Form 140PY, Line 32, in the subtraction section of
the forms.

California
Schedule IW, Line 17, is limited to zero.

State nontaxable Tax Exempt Interest from a 1099-DIV flows correctly to Schedule CA, Line 8.

California Electronic Filing
Prior business name (Form 568, Line GG(2)) populates with the current LLC name if no entry is made on 568
> General > Prior business name if different.

Connecticut
Single taxpayers with a Connecticut adjusted gross income that is more than $42,000, and equal to or less
than $43,000, receive a personal exemption of $500.

Georgia
Credit number 102, Employer's approved employee retaining credit, is limited to 50% of tax liability on Form
500, Page 2, Line 16.

Georgia has adopted the provisions of all federal acts as they relate to the computation of federal adjusted
income that were enacted on or before January 1, 2015. The following items are no longer added back:

Form 500, Page 4, Schedule 1, Line 4, as other additions:
Educator expense deduction

Tuition and fees deduction

Qualified charitable contributions

Enhanced deduction for charitable contributions of capital gain real property

Form 500, Page 2, Line 12, or Form 500, Page 6, Line 10, as itemized deduction:
Deduction for state and local general sales tax

Qualified mortgage insurance premiums deductible as home

The Department of Revenue has provided a penalty relief for farmers or fishermen. The underpayment of
estimated tax penalty on Form 500-UET will not calculate if the return was filed by April 15, 2015 (instead
of March 2, 2015).
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Hawaii
Form 8282 now shows the address of the donee organization.

Form N-342, total output capacity field, now works correctly.

The COLA adjustment is no longer included as an itemized deduction for state and local income taxes if the
adjusted gross income is over the threshold.

Illinois
Form 505-I, Line 2, picks up the pass-through withholding payments.

Schedule M, Line 2, picks up the sum of the Schedule K-1-T, Lines 30 through 35.

Illinois Electronic Filing
Form 1099-G does not generate in the electronic file when the unemployment compensation and
compensation repaid in 2014 nets to zero.

Indiana
IT-40RNR, Lines 5a and 5b, are limited to zero.

Total credits on Sch 6 or Sch G are limited to total tax on IT-40 or IT-40PNR.

Iowa
Exempt military retirement pay is not included in the pension/retirement exclusion on Form IA 1040, Line
21.

Form IA 1040, Line 13, includes all source gambling winnings and Form IA 126, Line 13, includes IA source
gambling winnings for non-resident returns.

The general sales tax deduction from federal Schedule A, Line 5 (when Line 5b is checked and itemized
deductions are claimed on the federal 1040) flows to IA Schedule A, Line 4 (and Line 4b is checked),
regardless of the state code entered on Income/Deductions > Itemized Deductions > State and Local Sales
Tax Information > State field(s).

Iowa Electronic Filing
Pass-through entries for the Investment Tax Credit flow to Form IA 148, Part IV.

Kansas
Form K-40PT will not generate if either taxpayer or spouse were born in or after 1949.

KS modification for net gain from sales of certain livestock allows Section 1231 property.

Schedule S, Part C, will not generate when Form 1040 is using the standard deduction, but Tax Equalization
forms are present and Tax Equalization forms are using itemized deductions.

Maine
Added input to allow entry of multiple occurrences of Capital Investment Credit From Pasthrough.

Tax Product Updates • 9



Schedule 1, Line 2d, Pension Income Deduction, will not include Maine Public Employees Retirement System
Pick-Up Contributions included on Schedule 1, Line 2g.

Maryland Electronic Filing
If income received during the nonresidence is greater than zero, one of the Residence Indicator boxes should
be equal to P.

Minnesota
Form M1MTC, Lines 26 and 27, are reduced by Line 16 of Form M1 and by the other non-refundable credits
on Form M1C. Disqualifying Diagnostic 42663 displays if amounts on Lines 26 and 27 are not reduced.

Form M1, Line 24, fills with the proper credit from Form M1CD, Line 13, for resident taxpayers with JOBZ
Business Income.

Missouri
Form MO-A line 11 does not include Qualified Health Insurance Premiums from SSA-1099 when it is attached
to a Schedule C and showing a deduction on Federal 1040, line 29.

Form MO-NRI part B, line S does not include Nonresident Property Tax.

Missouri - Kansas City
Form RD-109 is not referenced in letters or the return summary when the form is not included in the return.

Nebraska
Diagnostic 37627 no longer issues because Form 8453N is obsolete.

New Jersey
When New Jersey is the home state and a nonresident state is entered for a rental property and there are
federal passive activity loss carryovers, the carryovers are not included in the calculation of the New Jersey
income.

New Mexico
Input for the first date for election information has been added at the bottom of the PIT-B worksheet rather
than defaulting to current year end.

New York
Form NYC-208, Line 11, no longer includes pension distributions that have been rolled over.

North Carolina
Qualifying home mortgage interest amount on Schedule S, Line 13, includes points not reported to you on
Form 1098 from the Federal Schedule A, Line 12.

The Department of Revenue provides underpayment of estimated tax interest relief to farmers and
fishermen. The underpayment of estimated tax interest on Form D-422 will not calculate if the return was
filed by April 15, 2015 (instead of March 2, 2015).
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North Dakota
Negative amounts will not populate on form ND-1, Line 23, when amounts are present on Schedule RZ, Page
2, Line 10.

Ohio
Amount paid with the extension now includes refundable credits in the calculation.

Form 2023 and Form SBD no longer include SE income from a passthrough on Line 1a.

Form IT 1040, Line 15 adoption credit is now the greater of 1,500 or the amount of expenses incurred not to
exceed 10,000.

Form OR 40 will omit dependents that are marked as "Pro Forma only" from print.

Form SBD, Line 9a self employment tax is now limited to the federal amount.

Self employment tax calculates correctly now on Form IT SBD, Line 9a, when Form 2023 is not present in
the return.

Taxable social security benefits now show on the correct line of Form 2023, Page 2.

Ohio - Ohio Cities
Columbus Form IR-25. The preparer signature block has been updated to provide the preparer's PTIN in place
of the preparer's EIN when a PTIN is available.

RITA Electronic Filing. When the overpayment for a city is below the city's threshold to issue a refund, the
overpayment will be automatically applied to the next year's estimated tax. This prevents the need for a
government form override which can result in a schema validation error.

Schedule Y Allocation. If the total of the city specific allocation entries do not equal the total everywhere
allocation entries, negative allocated income will no longer be produced.

Oklahoma
The option to calculate a credit for a Contribution to an Educational Improvement Grant at 50% or 75% is
available on the Oklahoma Credits > Other credits section > Form 511-CR.

Oregon
Statement for OR 40, line 13 calculates as the line instructions state.

Pennsylvania
If interest from 1041 K-1 is already reported on Schedule J, it is not reported on Schedule A.

S Corporation distributions for Schedule RK-1 only flow to Line 15.

Schedule A, Line 1, excludes the amount of interest reported on Form 8815. Also, a white paper statement
shows this breakdown.

Schedule A, Line 11, picks up distributions from life insurance, annuity, or endowment contracts when no
other information is flowing to Schedule A.

Schedule A, Line 2, reports tax-exempt interest.

Schedule D-1, Line 14, will not allow negative amounts.
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Schedule D reports Form 6781 gains and losses on Line 1 instead of Line 6.

Schedules A and B calculate jointly filed forms when all interest or dividends are jointly reported.

Schedules A and B create taxpayer and spouse forms when using consolidated interest and dividends input.

US Bond Interest flows to Schedule B, Line 3.

Pennsylvania - Pennsylvania Cities
Form CLGS-32-1, Line 15, applies entire refund to next year's estimates when estimate is suppressed and
application of overpayment code "7" is selected.

Print of preparer signature on Form CLGS-32-1 follows federal standards.

The Pennsylvania Cities return attaches Federal or Pennsylvania forms based on which forms are used.

Pennsylvania - Philadelphia Electronic Filing
Form BIRT-EZ, Page 2, Line 1 or 2, will be present in the electronic file.

Pennsylvania Electronic Filing
Schedule D, Line 1, shows "Various" when "Various" date sold is used on Form 4797.

Philadelphia
Electronic filing of Forms BIRT/BIRT-EZ and NPT no longer requires changing input on Philadelphia > Net
Profits Tax and Business Income & and Receipts Tax > General > File BIRT/BIRT-EZ electronically and File
NPT electronically and recalculating the return to select which return is available for export. Instead, both
returns are allowed at the same time. Customers still must export and transmit one return at a time from
the Select Returns for export window (File > Export > Electronic Filing > Return). After the first Philadelphia
return has been accepted, export and transmit the other Philadelphia return unchecking the first return on
the Select Returns for export window.

Form BIRT correctly carries overpayment to NPT when requested.

Form BIRT prints City Account Number at the top of BIRT Schedules A, B, C-1, D and E.

Form NPT payment voucher shows the correct amount when BIRT overpayment has been applied to NPT
balance due.

White paper statement for BIRT-EZ, Page 2, Line 7b, correctly reflects the amount for the specific entity.

South Carolina
Form 1040, Line p-3, calculates $10,000 when the spouse is over 65.

Schedule TC-44 does not create a carryover if Line 8 is not greater than 0.

Texas
When using the cross over feature to view a Texas franchise return inside of the individual system, Form 05-
102 displays the registered agent's information.
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Vermont
Form IN-111, Line 14c, Adjustment for prior years' Bonus Depreciation, calculates for all nonresidents/part-
year residents as well as full-year residents.
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Partnership (1065) Product Updates
Return to Table of Contents.

Federal
Adjusted gain (loss) from rental activity that is tied to sale or disposition of assets and input as state only
entries are not included on the federal schedule of activities.

Diagnostic 10367 was updated to use the appropriate capital amount, beginning or ending, as the basis for
transfer.

Form 1065-B, Schedule K-1. Section 754 depreciation is now included on Form 1065B, Schedule K-1, Box 2,
taxable income from other activities.

Form 8949 attached to Form 8865 will not print when the option to suppress this form printing is selected
under Foreign > 8865 - Return of U.S Persons with Respect to Certain Foreign Partnerships > Foreign
Partnership Information > Line 35, Suppress print of 8865 level Schedule D and Form 8949.

Line 13d was updated to prevent doubling of 754 depreciation from portfolio depreciation totals.

Line 20M was fixed to prevent an amount from staying on the line if the input is removed.

Input has been added on Depreciation and Amortization (Form 4562) worksheet > field Real 179 C/O field
has been added to adjust the current year activity report when there are assets that were created from
disallowed real property section 179.

Part III, Line 32, should be left blank when there is only amount created by Form 6252, and "N/A" print next
to the line. However, if there are also amounts other than from installment sales that are also included in
Part III of Form 4797, those regular amounts will now appear on line 32 and the "N/A" will not print. This
presentation matches what regular 4797 is already doing.

Personal use portion is now applied to carryover of other rental expenses.

Rhode Island Forms 4868PT and 4868C print positions will change due to new state specifications.

The allocation of portfolio depreciation has been updated.

The allocation of Section 179 expense disallowed due to the business income limitation has been fixed.

The cross reference was updated to reflect every input for recourse liabilities.

The IRS again has revised the ZIP codes to be used for Form 3115.

Alabama Electronic Filing
Electronic filing diagnostic 46239 will now issue correctly for short year dates entered on Form PPT when a
calendar year has been indicated.

Form BPT-NW will no longer be automatically activated when Form PPT, Page 2, Line 10, includes an FEIN.

Arizona
The Fiscal year check box at the top of K-1 forms will now be checked when fiscal year dates are present in
the General > Basic Data worksheet.

Form 140NR calculation of composite tax for partners with filing status "X" (married filing separate) and also
claiming dependents now includes the correct personal exemption amount.
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Arkansas
AR1099PT will be included in the K-1 print package.

AR1099PT, Part B, has been updated to print the partner's city, state, and ZIP code.

AR1050, Line 22, has been updated when other deductions override is used. The amount will not double.

California
Form 568, Line 15, calculation of penalty for underpayment of estimated LLC fee, will consider the prior
year LLC fee and amount of overpayment from prior year allowed as a credit on Line 8.

Form 568, Schedule IW, Line 8b, will no longer include amounts that do not come from passthroughs or
overrides.

Form 592 (2014) will print the withholding agent's foreign postal code on the ZIP code line.

Government form overrides will no longer disappear on Forms 3885P and 3885L.

If Schedule B, Line 1c, is $3,000,000 or more then Schedules B and K will print when California > General
Information > Single Member LLC > Suppress forms for a disregarded entity has been selected.

Paragraphs regarding direct debit of annual and estimated fees were added for letters and filing
instructions.

Per the Web Pay Business FAQs, nonresident withholding cannot be paid via Web Pay. The letters and filing
instructions will no longer show the website for Forms 592 and 592-A.

Prior year Form 3536 letters and filing instructions will be produced even when using the electronic
payment filing instructions code on California > General Information > Basic Data.

Schedule R, Page 3, Part B, Columns b and c, will print 0 when an amount is present in Column a.

California Electronic Filing
0 will print on Form 568, Line 1, when there is no income.

565 returns can be electronically filed during the same export with Texas. 568 returns still require a
separate export.

Diagnostic 42361 will no longer be issued when the withholding agent has a foreign address.

If the SOS file number is '000000000000' and it is an initial return, the electronic file will use 'Applied For' in
this field as required by the Franchise Tax Board.

California Magnetic Media Filing
Magnetic media is available for filing Schedule K-1's.

Colorado Electronic Filing
A modification has been made to ensure a clean electronic file when filing using the Form 8453 signature
form.

Delaware
US Bonds have been subtracted from Delaware 300, Page 1, Line 8, Column B.
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District of Columbia
Form D-30, Line 47, will print only when Form 2220 is attached.

Hawaii
Schedule D-1, Column b, date acquired, has been updated to allow it to print "Varies" when all 9's are used
as input for the date acquired.

Illinois
Federal statements will no longer print in the accountants copy.

Form IL-505-B will calculate based off of line 60, total net replacement tax and pass-through withholding
payments, less payments other than extension payments.

If Schedule M-3 is attached to the federal return, Form IL-1065, Line M, will check the appropriate box.

Schedule B, Page 2, Column E, Member's Share of Distributable Base Income or Loss, now matches the
worksheet in the instructions. A statement for each member will now print with Schedule K-1-P showing the
calculation.

Schedule B, Step 2, Columns B and F, will reflect the partner type overridden on Federal > Common State >
Generic State Schedule K-1 Information > Generic Partner Input > State use - code 1.

Indiana
The Form WH18 recipient address will now display the name continued when present on worksheet Partners
> Partner Information section.

IT-20S K-1, Line d, will now print the Federal ID number when a withholding amount is present on Line d.

IT-20S K-1, Page 2, Lines 18 through 26, will now include Code 137.

Kentucky
Form PTE-WH custom filing instructions will no longer include underpayment penalty if not being included
in return.

If Kentucky Partnership (765/765GP) > Payments / Penalties > Underpayment Penalty Nonresident
Withholding > Exclude penalty from Form 740NP-WH is checked the underpayment penalty and interest will
not flow to the return or to the letters.

Massachusetts
Massachusetts Schedule 3K-1, Line 6, will now pull the Federal specially allocated amount when special
allocation code 7003 is entered 7 Special Allocations worksheet > Special Allocation Detail.

The preparer name on Massachusetts Form 3, Page 1, has been updated to always print under the 'Print paid
preparer's name' line and it will only print under the 'Paid Preparer's signature' line when 'Print preparer
signature' is selected on General > Return Options > Preparer Information - Overrides Office Manager
>section or in the return configuration set.

The PTE-EX information will now print in the K-1 copy of the return instead of the accountant's copy if a
code 3 is entered Massachusetts Other worksheet > Passtrhrough Entity Members' Information section > Form
PTE-EX options equals 'Print Form PTE-EX in K-1 Copy'.
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Michigan
Form 807, Schedule A, B and C, Columns 1 and 2 amounts, will now be calculated correctly when the MI
special allocations are used to allocate amounts to the different partners on their Schedule K-1s.

The worksheet cross references have been updated for Form 4918.

Minnesota
Form KPC, Line 22, now shows the correct amount for partner's share of total everywhere amounts for
Property and Payroll.

Option on Minnesota > General > Options to suppress print of Partnership Estimated Tax Payment forms when
M3 is electronically filed now suppresses print of the estimate forms.

When the option to suppress print of K-1 forms is selected, this will now also suppress print of Minnesota
Source Income worksheets.

Mississippi
The paragraph for 21-002 in the MS filing instructions/transmittal letter will not appear when form O-12 Box
42 = F and Box 43 = Blank, or when 0-12 Box 42 = S/F and Box 43 = any state besides MS (Other>2848 Power
of Attorney > Lines 2 and ).

Montana Electronic Filing
Diagnostic 48654 has been added to ensure the proper entity type is entered for each partner. Montana does
not allow an entry of "Other" for the entity type.

New Hampshire
The State Sale of Assets Worksheet will now generate for New Hampshire to show the difference between
New Hampshire and Federal for the Sale of Assets. Form NH-1065, Business Profits Tax Return, Page 2, Line
2(f), has been updated to fill with sale of assets differences between New Hampshire and Federal from the
State Sale of Assets Worksheet.

Form BT-Summary, Business Tax Return Summary, Page 3, Preparer's Signature & Information section, Email
Address line has been update to pull from the email address that is entered in the return configuration set.

Form DP-10, Interest and Dividends Tax Return, Line 7, Adjusted Taxable Income, and Line 9, Net Taxable
Income, have been updated to allow negative amounts, and Line 10, New Hampshire Interest and Dividends
Tax, will not calculate less than zero.

New Hampshire Electronic Filing
The New Hampshire government copy has been updated to include the federal copy for non-efiled returns.

New York
Form IT-204-IP, Lines 21 and 23, will show totals from all Lines 20 and 22 when nonresident partner is
chosen to not print in Government form and there is no NY source income.

Forms will now show last 4 of SSN/EIN if masking option to show last four is chosen. If masking is chosen
without the option to show last four then the entire SSN/EIN will be masked.
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New York City Electronic Filing
Disqualifying diagnostic 46241 has been added to prevent schema validation errors when there are negative
percentages on NYC-204, Schedule E, Part III.

Ohio
A statement listing partners or equity investors who received guaranteed payments, and their respective
share of amounts received, will now print when Question 2 is checked "Yes" on Form IT 4708, Page 1.

The Form 1140 filing instructions were updated to reflect the due date correctly.

Oklahoma
The Oklahoma oil and gas depletion deduction amounts can now be calculated based on the state
percentage depletion rates entered on the Depletion worksheet.

The Partners' Oklahoma allowable Oil and Gas depletion amounts calculated on the Oklahoma Schedule K-1s
and on Form 514, Part 5, Line 9, will no longer be limited to 50% of net income.

Oregon
The cover sheet will no longer print twice.

Rhode Island
Form RI-1040C, Line 20 (Underestimating Interest), from form RI-2210C or user override will now clear
when input filling this field is removed from the return.

Payment Voucher paragraph for RI-1040C-V will not print in the filing instructions when the RI-1040C is
showing a refund.

Rhode Island Electronic Filing
Form RI-1065V will automatically print upon export of RI electronic return if there is a balance due and
electronic withdrawal is not authorized.

Tennessee
Schedule J intangible expenses is now included in the total additions line for both FAE 170 and 174.

Schedule U is available for print when entries are on year 14 or 15 only.

Texas
Check boxes on 05-166 for "Corporation/LLC" or "Not a Corporation/LLC" will now appropriately check when
using the combined report feature.

Vermont
Calculated capital gains will be included when an entry is made on the worksheet Vermont Payments
Worksheet > Tax Payments Section > Income Directly Allocable to this Entity by this Entity; when an entry
has not been made for the amount of capital gains included in the income amount.

Form BI-470 mailing address, Line 1, will be now filled out when prepared with Form BI-476.

Tax Product Updates • 18



Special Allocation Codes to allocate specific items of income and deductions, 48037, 48039, 48081, 48083,
48085 have been added to the Federal > Special Allocation worksheet.

The recipient information section of the Form K-1VT will change to the reporting entity information for
composite returns with a single nonresident member.

Virginia
Form 502 extension transmittal letter will now include the paragraph directing taxpayers to the payment
guide website.

Obsolete input on Virginia > Composite > Extended due to sever storms has been made inactive. The return
due date will not be extended by one month when this field is checked.

Wisconsin
Allocation code 53897 has been added for the Agriculture Credit computed for prior years to the extent not
included in federal income.

Form 3 Schedule 3K allows the maximum amount of Section 179 of 500,000 dollars when either totals
depreciation is used or assets are input individually.

Form PW-2, Part I, Question 6, now has new input on the Wisconsin > Form PW-2 > Withholding Paid by
Another Entity worksheet section.

The Allocation of Depreciation Basis Adjustment worksheet section have been added to allow preparers full
control of how the pre-2014 basis of assets adjustment is presented on Schedule 3K and 3K-1.
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Corporation (1120) Product Updates
Return to Table of Contents.

Federal
Charitable and portfolio deductions from passthrough entities are now included in Line 4 of Form 6198.

Grammar in the extension paragraph has been fixed.

Form 114 and 114A were updated to include the continuation name input for the company name.

Form 5472, Part II, Line 1b(2), will now allow up to 18 characters to report the reference ID number.

New input on Depreciation and Amortization (Form 4562) worksheet > field Real 179 C/O field has been
added to adjust the current year activity report when there are assets that were created from disallowed
real property section 179.

Schedule G (1120C) - Passthrough partnership losses are now included in other deductions of Schedule G.

The filing instructions for supporting federal forms were updated to ensure they always print when
produced.

The references to the state/city in the electronic filing paragraphs have been removed. They were
redundant and at times made the paragraph too long for the space allowed.

Alabama Electronic Filing
Electronic filing diagnostics 45677, 45915, and 45988 will no longer issue when the federal type of return
indicated is "Other" on NYC-3L, NYC-4S and NYC-4SEZ forms.

Alaska
Schedule E taxes will not calculate when the corporation is a Personal Service Corporation.

Arizona
Diagnostic message 27017 now correctly identifies Arizona apportionment schedule as Schedule E.

Form 120, Schedule A, Line A-1, now includes the correct amount of federal depreciation when input is
present indicating business use is less than 100%.

California
When a return has no tax due, but the override to force electronic payment of estimates is activated, the
transmittal letter and filing instruction will now state that payments must be made electronically and will
reference the FTB Web site address.

When the federal return is a 1120 REIT and California is filing a 100 return, the rental income will no longer
be doubled on the California return.

California Combined
Elimination Company Combined Returns. The California combined program will now follow the federal
consolidated program in having the parent and elimination company use the same FEIN.
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Colorado
A modification has been made to ensure the complete first and last name of the preparer is shown on the
bottom of Form 112 for the person preparing the return.

Colorado Electronic Filing
Additional diagnostics have been created to ensure complete and valid addresses are included for the
Colorado Schedule C.

Connecticut
Form CT-1120AB, Page 6, Section B, Lines A and B, will now be check when input is present on worksheet
Connecticut > Other worksheet > Section 3, Lines 12 and 14.

Connecticut Electronic Filing
Corporation extensions will no longer be stopped for "Missing state information."

District of Columbia
Form D-20, Sch I, Column 6, now shows only book amounts for other expenses.

Georgia
A carry forward year on Schedule 11 has been added to match the federal Net Operating Loss Carryover
Deduction.

Illinois
Form IL-2220, Penalty Worksheet 1, calculation of underpayment penalty, will not complete when payments
are greater than or equal to estimate amounts due.

Kansas
Form AR, Annual Return letters, will no longer produce if the Annual Return has been suppressed.

Kentucky
Forms 5695-K and Schedule TCS will now produce when the qualified solar photovoltaic system-watts of
direct current is entered on Kentucky (720) > Credits > 5695-K Energy Efficiency Products Tax Credit.

Schedule LLET will now produce if Form 720, Tax reason code, is 22.

Schedule NOL for a consolidated return will show Part 1, Section A, Line 6, and Part I, Section B, Line 3, as
negative per form instructions. Schedule NOL, Part 1, Section A, Line 6, will flow to Form 720, Part III, Line
19.

Kentucky Electronic filing
Diagnostic 47004 will no longer issue if Schedule LLET, Section C, Line 2, is equal to zero.

Form 720, Schedule Q, Location of Books and Records when foreign address exist, the electronic file will no
longer add additional US address line in the electronic file.

Schedule NOL, Part II, Line 3, will now always equal Form 720, Part 3, Line 22.
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Montana
Form MT CIT, Line 3g, has been modified to calculate the charitable contribution deduction with any net
operating loss deduction excluded.

New York City
The program has been modified to print the member statement for banking combined return Form NYC EXT.

Pennsylvania
The Pennsylvania REV- Extension letter due date has been updated when the automatic extension option has
been selected.

Philadelphia Electronic Filing
Form BIRT-EZ will now have a valid Page 2 for electronic filing when the page has no values greater than
zero.

Texas
Check boxes on 05-166 for "Corporation/LLC" or "Not a Corporation/LLC" will now appropriately check when
using the combined report feature.

State code will now fill for officers on 05-102 Section A when entered at the Federal level.

The spacing in the filing instructions has been updated.

Virginia
FEINs entered as 999999999 or 555555555 will no longer pound out on Forms 854 and 8879, 500T (1120) and
502CR (1120S).

Form 502A manufacturer's factor will move from single factor to quadruple factor with tax years beginning
in June 2014. Retailers factor will move from quadruple factor to triple factor with tax years beginning in
June 2014.

West Virginia
Filing instructions have been updated to show the correct link for West Virginia electronic funds transfer.

Wisconsin
Form 6BL is now visible on screen.

Form 6BL. Control information no longer prints on the bottom of the form.

Form 6, Page 2, Line 1, accepts overrides for the parent company of the combined group when either the
Wisconsin > Combined Returns > Reconciliation to Federal Taxable Income worksheet section field 5 and
section 9 are input.
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S Corporation (1120S) Product Updates
Return to Table of Contents.

Federal
A condition has been added to allow the payment must be separately mailed paragraph to print for CT Form
IT-506C.

The word "us" has been added to one of the 8879-S paragraphs.

The condition has been changed to allow the letter to state to deposit your funds using EFTPS in the make
check payable section.

For New Jersey electronic filing, the filing instructions will now print with the government copy of the
return.

Form 114A was updated to reflect the type of taxpayer ID being used.

Illinois will no longer issue duplicate paragraphs for Form IL-516-B in the Estimate Reminder Letters.

New input on Depreciation and Amortization (Form 4562) worksheet > field Real 179 C/O field has been
added to adjust the current year activity report when there are assets that were created from disallowed
real property section 179.

The Federal and California extension letters will no longer issue duplicate paragraphs.

The New Hampshire State 4562 section 179 investment limitation is $200,000.

The New York letters will no longer state that the MTA Surcharge return should be filed with the New York
Franchise return when the return is selected for electronic filing.

The recapture of section 179 depreciation is reduced by the business use exclusion.

The total for the ending accumulated depreciation column in the small fonts landscape report totals
correctly when there are assets that have a code to force current depreciation entered with section 179
entered.

The West Virginia Form SPF 100 filing instructions will now align correctly on the page when General >
Electronic Filing > General > Transmittal letter / filing instructions paragraph option is "No further action -
return Form 8879-S."

Alabama Electronic Filing
A new auto-generated PDF called 'RETAINEDEARNINGS' will be produced to support both appropriated and
unappropriated retained earnings entered on Form BPT-NW, Line 29.

Form 8453-PTE now marks the check box to authorize discussion with the preparer when there is no tax
liability reported on Line 2 of the form.

Form BPT-NW will now take the return configuration set entry to force print of the federal balance sheet
when retrieving data to complete the form.

Form PPT, Part A, Line 5, will print a zero if blank for PPT taxpayer type 'S' and 'LS'. Electronic filing
diagnostic 49560 will no longer disqualify returns if Form PPT, Part A, Line 5, or Part B, Line 1, equals zero.

Forms NYC-579-GCT and NYC-579-BCT now print the ERO name when entered in the return configuration
set.
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The electronic filing ERO now prints the maximum length of characters in the IRS Attachment Name for PDF
attachments in the electronic return.

The PDF called 'BalanceSheet' is no longer a required PDF for Alabama and will not be part of the electronic
return file.

The self-employed checkbox on Form 20S will now be present in the electronic return file.

Arizona
Letters and filing instructions will no longer refer to mailing Form 120-EXT when there is no balance due and
the taxpayer has filed a valid federal extension.

Arkansas
AR Schedule K-1, final box, will check when the partner has been marked final on K-1, Box 116 or Federal >
Shareholders > Shareholder Information > Final K-1.

AR Schedule K-1, Line 2 will not include rental income (loss) when there is only "other" rental income(loss)
in the return.

The AR1000CRES - Extension voucher has been updated to print when tentative tax is used, also updated
Custom filing instructions.

California Electronic Filing
Diagnostic 46258 will issue when Form 592B, Part III, is missing an income type.

Diagnostic 46259 will issue when Form 100S, Page 5, Line 5, is negative.

Colorado
An adjustment has been made to ensure the estimated payment vouchers are updated when using the next
year estimate overrides.

Hawaii
You can now access the Explanation field for the Capital Goods Excise Tax Credit. This is Line 10 under HI >
Credits > Section 2 Capital Goods Excise Tax Credit.

Illinois
Form IL-1000-E cannot be used for individual and tax exempt members. Partnership diagnostic 47709 and S
corporation diagnostic 48216 will begin issuing once per invalid member.

Schedule B, Page 2, Column F, for exempt shareholders, can now be an "N" by marking Federal Worksheet
Shareholders> Shareholder Information> Detail> State Information> check box 1 for that shareholder.

Schedule NLD, net operating losses, will print when a net operating loss is calculated and reported on IL-
1120-ST.

Kentucky
Form KY 41A720SL will calculate Tax and LLET when entered on Federal > Other > Extensions > State/ City
Extension > Tentative Tax, Other taxes not based on income/other fee(s)/capital stock/foreign franchise
tax, Special use fields.
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Michigan
The cross reference has been updated for Form 807.

The letters and filing instructions for Form 4917 will reflect the correct due dates when Form 4917 is
forced.

The worksheet cross references for Form 807 have been updated.

Michigan - Detroit
Form D-1120, Schedule D. Apportionment override for total property now prints on Schedule D, Line 1b.

Michigan City taxes will now accrue correctly to Federal Form 1120S.

The Detroit tax return now prints in the government copy when mail sheets have been requested.

The statements for Form D-1120 return now print.

Minnesota
Input in Minnesota > Other Returns > Domestic Annual Registration, Line 1, no longer activates Form M8X.

Minnesota Source Income Worksheet Step 1 (Section 179 difference) now calculates correctly as the
difference between the shareholder's IRS Schedule K-1, Line 11, and the shareholder's MN Schedule KS, Line
4.

New Hampshire
NH-1120, Business Profits Tax Return, Line 6(b), Income taxes or franchise taxes measured by income, will
now include Michigan income tax.

New Jersey
Extension payment vouchers, Forms CBT-200-TC and CBT-200-TS, now properly include the 50% installment
payment on Line 2 when requested.

Override for CBT-200-TS tentative tax line no longer includes tentative tax override intended for Form 630
(Composite Extension).

New York
The program has been modified to allow overrides for installments due on Form NYC-222, Line 10.

Ohio
Supporting statements for Form IT-1140, Page 2, Schedule B, Line 2b, and Form IT-4708, Page 4, Schedule
III, Line 42, now include the correct amount for prior year(s) I.R.C. Section 179 expense.

Oregon
Q-2015 will now print correctly in the estimate filing instructions.

Schedule K-1 equivalent, Line 19, will no longer double credits.

The federal copy of the return will no longer print in the government view when Oregon has been selected
for electronic filing.
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The Schedule K-1 and K-1 equivalent will now calculate other adjustments on Line 13.

Pennsylvania
The extension amounts have been updated for the Pennsylvania REV-853, REV-276, and REV-276 NRC to
include accountant calculated amounts. Additionally, the REV-276 and REV-276 print conditions have been
modified to work independently of each other.

Philadelphia
The Pennsylvania city taxes shown at the federal level will now show the amount indicated from the filing
of the BIRT-EZ form when it is filed.

Rhode Island
Rhode Island > Income / Deductions > Subtractions > Section 179 depreciation input has been added to allow
you to designate Form K-1, Section III, Line 5, amounts.

RI-1120S, Form K-1 adjustment to federal depreciation for totals only input in the federal return now reports
on Form K-1, Section 2, Line 4.

South Carolina
SC1120S Schedule N, Line 5, ending period total for other property will now show the correct amounts.

The composite extension amount will no longer show as "Estimate Paid to Date" on Form SC1040ES.

Tennessee
The filing instructions and cover letter have been updated to indicate a payment is required via direct debit
when no banking information has been entered.

Texas
Electronic filing diagnostics 44787 and 44788 will no longer issue in error when filing a combined report.

The Officer zip code overrides will work correctly when entered at the Texas level for the 05-102.

Override for Texas Form 05-102 Section A zip code will fill when entered on TX4 box 85.

Vermont
Bonus depreciation override on VT worksheet > Income / Deductions section will now carry to Form BI-471,
Line C, when filing a composite return.

Form BI-471, Line 14 will pickup a payment entered on the Vermont Worksheet > Composite Return >
Payments Section.

Virginia
Form 502 extension transmittal letter will include the amount on Form 502, Page 2, Line 2, and the
payment guide website when applicable.
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Wisconsin
Form PW-1 will only be marked as final if that option is selected on the Common State > State/City Common
Data worksheet section Final Return field > General worksheet section final return field.

If the option to electronically file a balance due return is selected in the return configuration set and
electronic deposit or withdrawal are not selected in the return, the Form C-EPV payment voucher is
produced.

Schedule R can be produced in the consolidating unit of an S Corporation consolidated return.
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Fiduciary (1041) Product Updates
Return to Table of Contents.

Federal
California capital loss carryovers for regular and AMT will now roll forward correctly when federal capital
loss carryovers for regular and AMT are the same.

California transmittal letter paragraphs are now available for customization.

Form 3800, Part III, Line 4H, will bring over the total amount from Form 8941.

Form 541-B amounts will roll forward zeros if the federal system has an amount different from the
California amounts.

Mississippi Additional Filing Instructions will now print on a new page or panel of the standard filing
instructions, when necessary.

Other long-term gains will no longer include 5 year capital gains class twice.

Prior year accumulated NII qualified dividends will no longer be subtracted on the Ordinary Income
worksheet from the ordinary income amounts.

The resident state letter for Massachusetts residents will now accurately reflect short and long term gains.

The resident state letters for Massachusetts residents will only show Massachusetts bank interest if the bank
interest is actually sourced to Massachusetts.

Schedule K-1 will distribute correctly when 1231 gains are being distributed and capital gains are included
in ordinary income.

The Form 1041 statement with employer identification numbers for Section 645 election will now display
whether or not an election was made in the prior year.

The Schedule D tree menu has been updated to include the trust's listing of capital gains and losses for a
grantor type trust.

The Schedule K-1 and Form 8903 will now match in distribution amounts of DPAD.

The special interest codes of "5" or "6" will be applied against municipal bond interest. If no municipal bond
interest is present, it will be used against regular interest.

The Form 706-GS(D-1) paragraph will now display to mail by the 2014 date.

The transmittal letter for Form 541-T will now display the appropriate ZIP code in the mailing address.

Form 1099-R. Diagnostic 44944 will no longer issue if a payer's name and valid payer's identification number
are entered on the 1099-R.

Form 1099-R. Diagnostic 44945 will issue if an invalid ZIP code is entered for Missouri.

Foreign Financial Assets. Form 8938 has been moved in the tree menu to be in numeric order.

Form 8960. The amount calculated on Line 13 of the Form 8960, Line 7 worksheet will flow to Line 7 of
Form 8960.

Form 8960. A disqualifying diagnostic will now issue if Form 105, Line 2 or Line 4, is less than zero.
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Electronic Filing
The return configuration set default will now display on the General > Electronic Filing > General section >
Do not print nonfileable message on signature forms field.

Alabama
Disqualifying diagnostic 45038 will now issue when an invalid phone number has been entered.

Form 41, Paid electronically check box, will no longer be automatically selected when the balance due is
greater than $750.

Schedule G, Line 20 (composite payment), will now calculated for non-resident grantors.

Arkansas
Arkansas Schedule K-1, Line 13, Other Deductions, now calculates the Excess Deductions in a final year
return only when applicable.

Arkansas Electronic Filing
Diagnostic 44920 will no longer issue when the beneficiary last name is not entered on the Beneficiaries >
Beneficiaries Information (Detail) > General > Last Name field.

Colorado Electronic Filing
A diagnostic will now issue if no path is present when a PDF file is attached.

A disqualifying diagnostic will now issue if Form 105, Line 2 or Line 4, is less than zero.

Kansas
Form K-41, Part IV, will no longer calculate a tax amount for a nonresident trust with nonresident
beneficiaries.

Kansas Electronic Filing
Nonresident withholding tax will be calculated when requested from Kansas input.

Kentucky
When the federal and/or state depreciation is overridden, the statement for Form 741, Page 2, Schedule M,
Line 3 for other additions, will now reference federal depreciation instead of Kentucky depreciation.
Likewise, the statement for other subtractions on Line 7 will now reference Kentucky depreciation instead
of federal depreciation.

When the trust or estate is a resident of Kentucky, and Form 8582-K is not present, no passive adjustment
will be made on Form 741, Page 2, Schedule M. However, if the trust or estate is a nonresident, a passive
adjustment will now be present if nothing is sourced to Kentucky.

Louisiana
The complete Form IT-541 entity name will now print correctly.
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Massachusetts Electronic Filing
Disqualifying diagnostic 44766 will no longer issue for Self Employed preparers with no Federal EIN.

Michigan
The first quarter payment will now flow to Form 2210, Page 1, Part 1, Line 11, Column A.

Minnesota Electronic Filing
Disqualifying diagnostics will issue for incomplete decedent address information when the return is not an
Estate return.

Montana
Form FID3, Page 6, Schedule F, Line 15, will be limited to minimum of zero.

New Jersey
Line 26 will no longer calculate a tax when the option has been chosen for a resident trust that is not
subject to tax.

New York
New York IT-205-A, Page 2, Line 38, will now report negative DNI, when applicable. If it is not a final year
trust, the negative DNI will be reported on IT-205-A, Page 1, as belonging to the fiduciary only.

New York IT-225 will now have a code and amount for automatic DPAD addition calculated.

The New York grantor letters will now present U.S. interest as the net amount due to the IT-225. The
statement will remain as it is.

The New York statements for municipal bond interest expense allocation will no longer print if the override
is used for the expenses only.

New York Electronic Filing
New York electronic filing will now allow a grantor to file an extension.

New York electronic filing will now be able to transmit PDFs with a name 81 characters long.

Oregon
Oregon Form 41-V Extension Payment Voucher FEIN is now printing on the form.

Pennsylvania
Form PA-41, Line 2, will now match Schedule B, Line 11.

Out of state municipal bond dividends will correctly be added on Schedule B, Line 7.

Wisconsin
Short term capital losses distributed to the beneficiaries will show on Line 8c of Schedule WD.

The Grantor text for Section 671-678 IRC will print on Form 2 when selected.
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Estate & Gift (706/709) Product Updates
Return to Table of Contents.

Federal
In the Form 709 signature block, if the preparer's name will not fit on one line, it wraps to two lines.
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Exempt Organization (990) Product Updates
Return to Table of Contents.

Federal
The CA Form 3586 payment voucher mailing labels now have the correct ZIP code when the return has been
electronically filed.

The Federal 990-T Extension Letter will now include both the EFT payment paragraph and the paragraph
mentioning the date the return has been extended to.

The Federal Form 990W, Estimated Tax Filing instructions, will no longer truncate the word "Voucher" when
the option to print the letters and filing instructions in upper case has been selected.

California
If the corporation number is '0000000' or the temporary LLC number is '000000000' and it is an initial return,
the electronic file will use 'Applied For' in this field as required by the Franchise Tax Board.

Illinois
Form IL-1120-ES, Line 5, will subtract recapture of investment credits from Form IL-990-T, Lines 14 and 20.

Form IL-1120-ES, Line 6, will automatically pull Form IL-990-T, Line 28d, or the amount can be overridden
using Illinois > Business Income Tax Return (Form IL-990-T) > Estimate Preparation > Pass-through
withholding payments expected to be made on K-1-P or K-1-T - override.

Form IL-990-T-X, Lines A and B, the officer's phone number and the authorization to discuss preparer fields,
will pull data from Federal > Common State > General Information.

Form IL-990-T, Lines A, B, and C, the officer's phone number and the authorization to discuss preparer
fields, will pull data from Federal > Common State > General Information. The letters and filing instructions
for Form IL-990-T will show that the refund will be deposited directly when banking information is present
on Line 33.
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Employee Benefit Plan (5500) Product Updates
Return to Table of Contents.

Electronic Filing
Electronic filing of Form 8955-SSA is now available. The IRS issued the following electronic filing mandate:

Final Regulations issued under Internal Revenue Code Sections 6057, 6058 and 6059 (T.D. 9695) generally
require filers who have to file at least 250 returns with the IRS during the calendar year to file Form 5500-
series returns and Form 8955-SSA electronically. Form 8955-SSA, Annual Registration Statement Identifying
Separated Participants with Deferred Vested Benefits, must be filed electronically for plan years beginning
on or after January 1, 2014, but only for returns with a filing date on or after July 31, 2015 (not including
extensions).
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